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OpenRoads Designer (ORD) Survey Processing Guidelines 
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This document was developed as part of the continuing effort to provide guidance within 

the South Dakota Department of Transportation in fulfilling its mission to efficiently 

provide a safe and effective public transportation system through our core values of 

high ethical standards, stewardship, transparent public service, safety, teamwork, and 

innovation. This document is not intended to establish policy within the Department, but 

to provide guidance in adhering to the policies of the Department. 

Your comments, suggestions, and ideas for improvements to this document are 

welcomed.  
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Introduction to OpenRoads Survey 
 

OpenRoads Survey provides surveyors with effective tools to import, review and edit 

survey data collected in the field in a CAD environment. These guidelines have been 

developed as part of the SDDOT statewide implementation of OpenRoads Designer 

(ORD). The intent of this document is to provide guidelines and standards for processing 

survey data in ORD. Updates to this document will be made periodically when minor 

revisions, additional information, and/or enhancements are needed. 

 

Create a Survey Project 
 

1) Launch OpenRoads Designer from the desktop… 

 

 

 

2) From the WorkSpace drop-down menu select the appropriate Region (RegionA, 

RegionM, RegionP or RegionRC). 
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The WorkSpace is a set of files and configuration variables that define the SDDOT 

settings. Selecting the appropriate Region WorkSpace is important. 

3) From the WorkSet drop-down menu select Create Workset… 

 

 

 

The WorkSet sets specific standards, creates subfolders and points to the appropriate 

project folder within the appropriate Region folder on the U: drive 

(U:\regionX\prj\cntyPCN#). When a design file (dgn) is created or opened it is associated 

to the WorkSet that is chosen. Selecting or creating the appropriate WorkSet is important. 

The Create WorkSet dialog box will appear… 
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4) In the Name: field type in the appropriate project folder name (cnytPCN#). This will 

create the project folder on the U: drive (U:\regionX\prj\cntyPCN#) along with the 

desired subfolders where the new survey file will reside. 

5) From the Template: drop-down menu select the appropriate region template 

(_regionX_New_Project_Template) 

 

Note: If the project folder already exists on the U: drive prior to creating a new WorkSet 

select None from the Template: drop-down menu. 

 

6) Select the OK button located at the bottom of the dialog box. 

A new project folder along with subfolder will be created within the appropriate region 

folder on the U: drive (U:\regionX\prj\cntyPCN#). 

Note: If the project folder already exists on the U: drive prior to creating a new WorkSet 

and None was selected in step 5 above the subfolders will be created within the existing 

project folder. 

7) Create a 3D Survey dgn file by selecting the New File button . 

The New dialog box will appear… 
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8) Navigate to the dgn folder within the appropriate project folder within the appropriate 

region folder on the U: drive (U:\regionX\prj\cntyPCN#\dgn) where the new survey file 

will reside. 

a) In the File name: field at the bottom of the dialog box type in the appropriate survey 

file name (PCN#_T) 

b) Ensure the Save as type: is set to Micro Station DGN files (*.dgn) 

c) Ensure the Seed: field is set to utilize the 3D seed file by selecting the Browse 

button located in the bottom right of the dialog box  

The Select Seed File dialog box will appear… 

 

 

 

d) highlight the Seed3D – SD_DOT Design.dgn file. 

e) Select the Open button located in the bottom right of the dialog box 
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--Important-- 

The naming convention for the survey file should follow the SDDOT standard for naming 

a survey CAD file outlined in Topography Data Furnished (.dgn file) Chapter 6 of the 

SDDOT Survey Manual. 

 

9) Select the Save button located in the bottom right of the dialog box. The new survey 

dgn file will be created and opened. 

 

Ribbon and Workflows 
 

The main section of the interface is the Ribbon located along the top of the software and 

is the primary access to the Ribbon Tabs and Tool Groups. 

 

 

 

Review each area of the Ribbon by selecting each Tab. The Ribbon functions in a 

similar manner to the Ribbon found in Trimble Business Center and many Microsoft 

Office products. The Ribbon Tabs and Tool Groups are dependent on the workflow 

selected. For example, selecting the OpenRoads Modeling workflow will present a new 

set of Ribbon Tabs and Tool Groups. 

The Survey Ribbon Tabs and Tool Groups can be accessed by selecting Survey from 

the Workflow drop-down located in the upper left corner of the software. The Ribbon 

will now show the Ribbon Tabs and Tool Groups associated with the Survey 

workflow. 

 

Setting the Geographic Coordinate System 

 

1) Select the Survey workflow from the Workflow drop-down located in the upper left 

corner of the software. 

 

WorkFlow Ribbon Tab 

Tool Group 

File Tab 
(To BackStage) 

Quick Access Toolbar 

https://dotfiles.sd.gov/survey/smchap6.pdf
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2) Select the Utilities tab located along the top row of tabs. 

3) Select the Coordinate System tool  located within the Geographic tool group. 

 

 

 

The Geographic Coordinate System dialog box will appear… 

 

 

4) Select the From Library tool . 

The Select Geographical Coordinate System dialog box will appear… 
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5) Select the + icon next to the Library folder and navigate to the following folder… 

Projected (northing, easting, …) > North America > United States of America > 

South Dakota 

 

 

 

6) Select the coordinate system used for the field survey and select the OK button 

located in the bottom left of the dialog box. 

 

The Geographic Coordinate System is now attached. 

 

--Important-- 

Select the same coordinate system used to setup the job file in the data collector. 

 

7) Close the dialog by selecting the “X” located in the top right of the dialog box. 
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Setting the Drawing Scale 
 

1) Select the Drawing Production tab located along the top row of tabs. 

2) Within the Drawing Scales tool group set the Annotation Scale drop-down to the 

appropriate scale for the survey file. 

a) Rural – set Annotation Scale to 1” = 200’ 

b) Suburban – set Annotation Scale to 1” = 100’ 

c) Urban – set Annotation Scale to 1” = 40’ 

 

 

 

Create Field Book and Import Survey Data 
 

1) From the Explorer Tab expand the Survey Pane if not already expanded 

 

 

 

2) Select the drop-down arrow next to Survey Data 
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3) Select the drop-down arrow next to Default to expand the tree to display the default 

survey data folders. 

4) Right click on Field Books and select New…  

 

 

 

A drop-down arrow will appear next to the Field Books folder indicating a new field book 

has been created. 

 

5) Expand the Field Books folder by selecting the drop-down arrow next to the folder 

to view the newly created field book named Field Book 1. 

6) Right click on Field Book 1 and select Properties 

 

 

 

Field Book 1 properties will appear in the Properties Tab next to the Explorer Tab 

 

7) In the Name field type in the appropriate project field book name (PCN#) and select 

the enter key on the keyboard. 
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--Important-- 

The naming convention for the field book should follow the SDDOT standard for naming 

field books outlined in Field book Data Furnished Chapter 6 of the SDDOT Survey 

Manual. 

 

8) Right click on the newly created project field book in the Survey Pane and select 
Import > File… from the drop-down menu 

 

 

 

The Select file dialog box will appear… 

 

 

 

9) From the File type drop-down menu select SD_DOT CSV with Notes(*.csv) 

https://dotfiles.sd.gov/survey/smchap6.pdf
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10) Navigate to the location of the .csv file containing the field survey. 

11) Double click on the .csv file to import the field survey data into the projects field book. 

Repeat steps 8 through 11 until all .csv files have been imported 

 

12) Select the Fit view tool  within the View Control toolbar located at the top of the 

CAD drawing space to graphically display the field survey data. 

 

Importing Multiple Survey Data Files - Drag and Drop Process 
 

To import multiple .csv files into the project field book use the drag and drop process. 

After the project field book has been created in steps 1-7 above 

 

1) Open windows explorer and navigate to the location of the .csv files containing the 

field survey. 

2) Select all the .csv files to be imported and drag-and-drop them onto the newly created 

project field book folder inside the Survey panel. 

 

The Data Format dialog box will appear… 

 

 

 

3) Select SD_DOT CSV with Notes and select the Apply button 

 

The import window will reappear for each .csv file that was dragged-and-dropped into 

the field book folder. Simply select the Apply button for each file or select the Apply All 

button to import all the .csv files at once. 

 

4) Select the Fit view tool  within the View Control toolbar located at the top of the 

CAD drawing space to graphically display the field survey data. 
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Displaying the Background Map 
 

One feature of OpenRoads Designer that is useful when processing survey data is the 

background map feature. This feature is a good check to insure the correct Geographical 

Coordinate System was set. 

1) Select the drop-down arrow next to the View Attributes tool  within the View 

Control toolbar located at the top of the CAD drawing space 

 

The View Attributes pane will appear… 

 

 

 

2) Set the Background Map Type: to Aerial 

 

The aerial image will display in the CAD drawing space. Setting the Background Map 

Type: back to None will turn off the background map. 

 

Reviewing and Editing Survey Data 
 

Point numbers, Field Codes, Elevations and Descriptions known as decorations in 

ORD can be turned on and off by using the Decorations tool group located under the 

Analyze tab. 

 

1) Select the Analyze tab located along the top row of tabs. 
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2) Within the Decorations tool group select the Names decoration and the Field Code 

decoration to display the point names and field codes in the CAD drawing space. 

 

 

 

Coding errors can be searched for and edited 

1) From the Explorer Tab expand the Survey Pane if not already expanded 

2) Expand the following folder within the Survey Pane by selecting the drop-down 

arrow next to each of the following folders 

Survey Data>Default>Field Books>(PCN#)>ALL Point Features 

3) All incorrect field codes within the field book will display in red 

4) Select the red code errors and then select the Details tool  located within the 

Primary tool group 
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5) The Survey Details dialog box will appear showing the field code errors 

 

 

 

6) Click in the first column with the arrowhead to zoom to the point in the CAD drawing 

space 

7) Click in the Field Code column and fix the field code errors selecting the tab key on 

the keyboard after each correction 

8) Close out of the Survey Details dialog box by selecting the X in the upper right of the 

dialog box 

9) Repeat steps 4 through 8 for each incorrect field code shown in the All Point 

Features list within the Survey pane 

 

Join Point (or JPT) is a control code that connects a feature line from the point the 

control code is associated with to a point number specified following the Join Point 

control code. 

 

1) Select one of the feature lines within the CAD drawing space to highlight the feature 

line. 
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2) Hover over the selected feature line to display the Civil Context Menu 

 

 

 

3) Select the Edit Point Features tool  

The Survey Details dialog box will appear…. 

 

4) Click in the Control Codes field of the point to be edited to display the Control Code 

ellipsis. 

5) Select the ellipsis to display the Control Codes dialog box 
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6) Select the Add icon  located at the top of the Control Codes dialog box 

7) From the Control Codes drop-down menu select the JoinPoint Control Code 

 

 

 

8) In the Value field type in the point number to join to and select the tab key on the 

keyboard to accept the point number 

--Important-- 

Ensure the tab key is selected after entering the point number in the Value field. This 

will ensure the cursor is cleared from the Value field allowing the point number to be 

saved. 

 

9) Select the Accept icon  located at the top of the Control Codes dialog box to 

complete the command and update the graphics within the CAD drawing space. 

 

 

 

10) Repeat steps 3 through 9 until all lines have been joined.  
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Join Linear Features is a tool found within the Civil Context Menu that enables two 

linear features (line segments) to be joined together into one continuous linear feature 

(line segment). To be able to use the Join Linear Features tool the two linear features 

(line segments) will first need to be converted to Point List Linear Features and then 

joined together using the Join Linear Features tool. 

1) Select one of the linear features (line segments) to be joined within the CAD drawing 

space to highlight the feature line. Hover over the highlighted linear feature (line 

segment) to display the Civil Context Menu and select the Convert to Point List 

Linear Feature tool  

 

 

 

2) Repeat step 1 for the second linear feature (line segment) to be joined together 

3) Select one of the newly converted linear features (line segments) to be joined within 

the CAD drawing space to highlight the linear feature (line segment). Hover over the 

highlighted linear feature (line segment) to display the Civil Context Menu and 

select the Join Linear Features tool  
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4) Select the second linear feature (line segment) to be joined and left click to accept 

 

The two linear features (line segments) are now joined together 

5) Repeat steps 1 through 4 until all lines have been joined.  

 

Creating and Editing Terrain Model 

 

Before creating the terrain model, it is best to Compress the dgn file to reduce the size 

of the file and remove unused element types from the dgn file.  

1) Select the File tab located along the top row of tabs to access the BackStage 

2) Select Tools from the list along the left side of the BackStage to display the Tools 

options. 

3) Select Compress File from the Tools option list to compress the dgn file. 
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Note: This process may take several minutes to complete. 

Once the Compress File process is complete the message File Compressed will 

display in the Message Center at the bottom of the software. 

After compressing the dgn file the Terrain Model can now be created.   

1) From the Explorer Tab expand the Survey Pane if not already expanded 

2) Right click on the project field book in the Survey Pane and select Create Terrain 
Model… from the drop-down menu 

 

 
 

3) Select the Terrain tab located along the top row of tabs. 

4) Within the Edit tool group set the Boundary Options drop-down to Add Boundary 

 

The following dialog box will appear… 

 

a) Change the Method field to Add Ruled Boundary from the drop-down menu 

b) From the Feature Definition drop-down menu open the Terrain Feature 

Folder and select RuledBoundary 
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c) The Name field should default to Existing 

d) Select the terrain model edge graphically in the CAD drawing space and left 

click to accept and create the Terrain Model’s Ruled Boundary 

Triangles can be turned on and off in the properties tab by selecting the Terrain Model’s 

edge with the Select Element  tool. The E_TERRAIN_RuledBoundary is also 

located along the edge of the Terrain Model. Ensure the Terrain Model: (PCN#) is 

selected by hovering over the terrain model’s edge and right click to cycle between the 

E_TERRAIN_RuledBoundary and the Terrain Model: (PCN#). When the Terrain 

Model: (PCN#) is highlighted right click to display the Terrain Model properties. 

 

The triangles display can be turned on or off by double clicking on the Triangles setting 

 

 

5) Select the Drawing tab located along the top row of tabs and use the Modify tool 

group to edit the terrain model’s ruled boundary using the following tools: 

 

 

 

Modify Element use to move an existing vertex of the terrain model’s ruled 

boundary element to a new location 



22 
01/20/2023 

Insert Vertex use to insert a single vertex of the terrain model’s ruled boundary 

element and move it to a new location 

Delete Vertex use to delete an existing vertex of the terrain model’s ruled 

boundary element 

 

-IMPORTANT- 

Do not break, clip, or delete the terrain model’s ruled boundary element only modify, 

insert, or delete the terrain model’s ruled boundary vertexes using the above-

mentioned tools. 

 

Review and Editing Crossing Features 
 

Report Crossing Features is a tool found in the Reporting drop-down menu within the 

Analysis tool group under the Terrain tab. The Report Crossing Features tool provides a 

list of all crossing features (line segments) within the survey. Using the report zoom to the 

crossing point of the features (line segments) and edit the feature lines (line segments). 

1) Select the Terrain tab located along the top row of tabs. 

2) Select Report Crossing Features from the Reporting tool   drop-down menu 

located in the Analysis tool group. 

 

The Terrain Model Crossing Features dialog box will appear… 
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3) Ensure the Apply Elevation Tolerance is checked 

4) Enter in a tolerance value into the Elevation Tolerance field and select the enter 

key on your keyboard 

5) Select the terrain model’s edge  and right click through the on-screen heads-up 

prompts attached to the cursor to display the Terrain Crossing Features Report. 

 

 

6) Highlight one of the intersection points within the report dialog box and select the 

Zoom To button at the top of the report box to zoom to the intersection of the 

crossing feature lines (line segments). 

7) Edit the feature lines (line segments) as needed to fix the crossing feature line. 

8) Repeat steps 6 and 7 until all crossing feature line issues have been resolved. 

 

Annotate Notes 
 

1) Select the Drawing Production tab located along the top row of tabs. 

2) Within the Annotations tool group select the Element Annotation tool  

The Annotate Elements dialog box will appear… 
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3) Check the box next to All Elements in Model 

4) Move cursor into CAD drawing space and left click to annotate all elements in model 

Note: this process may take 30 minutes to complete. 

Once the Annotate Elements process is complete the field notes will display in the CAD 

drawing space. 

 

Finalizing OpenRoads Survey File 
 

1) Select the Home tab located along the top row of tabs. 

2) Within the Attributes tool group expand the levels and select Display… 

 

 

The Level Display dialog box will appear… 
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3) Turn off the following levels by selecting the white dot in the Used column 

a. E_TERRAIN_Triangles 

b. E_TERRAIN_RuledBoundary 

c. S_TOPO_Discon 

4) Close the Level Display dialog box by selecting the “X” in the top right corner of the 

dialog box 

5) Select the File tab located along the top row of tabs to access the BackStage and 

select Save Settings to save the levels displayed within the CAD drawing space. 

 

Converting OpenRoads Designer to InRoads and MicroStation 
 

After importing, editing, and processing all field book data and all modifications have 

been made to the Terrain model. The OpenRoads Designer file can now be converted 

to be used for design in MicroStation SS4 and InRoads SS2. 

 
Note: Before converting the OpenRoads Designer file check to ensure the correct 

Annotation Scale was set in the Setting the Drawing Scale section of this manual. 

1) Hover over an element of the terrain model to display the Civil Context Menu 

2) From the Export Terrain Model tool drop-down select InRoads DTM 

 

 

The Export Terrain dialog box will appear… 

 



26 
01/20/2023 

 

 

3) Navigate to the appropriate project folder within the appropriate region folder on the 

U: drive (U:\regionX\prj\cntyPCN#) where the InRoads surface model file will reside. 

4) In the File name: field at the bottom of the dialog box type in the appropriate surface 

model name (PCN#_org). 

Note: Use the under bar ( _ )in the file name between PCN# and org to signify the file 

was created in OpenRoads Designer. 

 
--Important-- 

The naming convention for the surface model should follow the SDDOT standard for 

naming the surface model file outlined in Surface Data Furnished (.dtm file) Chapter 6 

of the SDDOT Survey Manual. 

 

5) Select the Save button located in the bottom right of the dialog box to save the 

exported DTM. 

6) From the Explorer Tab expand the Survey Pane if not already expanded 

 

https://dotfiles.sd.gov/survey/smchap6.pdf
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7) Select the drop-down arrow next to Survey Data 

8) Select the drop-down arrow next to Default to expand the tree to see the default 

survey data folders. 

9) Select the drop-down arrow next to the Field Books folder to expand the tree to 

see the project field book. 

10) Uncheck and recheck the box next to the project field book (PCN#) to ensure all 

survey data is visible. 

11) Right click on the project field book (PCN#) and select Export To > DGN 

Graphics… from the drop-down menu 

 

 

 

The Save visible survey data dialog box will appear… 
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12) Navigate to the appropriate project folder within the appropriate region folder on the 

U: drive (U:\regionX\prj\cntyPCN#) where the MicroStation DGN Graphics file will 

reside. 

13) In the File name: field at the bottom of the dialog box type in the appropriate 

MicroStation DGN Graphics file name (tPCN#_*.dgn). 

_                                       signifies the file was created in OpenRoads Designer 

*                                            represents one of the three design file scales and is always lowercase: 

r = Rural Scale (Insure Annotation Scale is set to 1” = 200’) 

s = Suburban Scale (Insure Annotation Scale is set to 1” = 100’) 

u = Urban Scale (Insure Annotation Scale is set to 1” = 40’) 

Note: replace the * shown in the MicroStation DGN Graphics file name with one of the 

three design file scales letter (r, s, or u) 

--Important-- 

The naming convention for the DGN Graphics file should follow the SDDOT standard for 

naming the DGN Graphics file outlined in Topography Data Furnished (.dgn file) 

Chapter 6 of the SDDOT Survey Manual. 

 

14) Select the Save button located in the bottom right of the dialog box. 

The newly created MicroStation SS4 file (tPCN#_*.dgn) will automatically open in 

OpenRoads Designer. This may take several minutes to completely load. 

15) Close the newly created MicroStation SS4 file (tPCN#_*.dgn) by selecting Close 

within the File tab along the top row of tabs to exist out of the newly created 

MicroStation SS4 file (tPCN#_*.dgn). 

 

The exported MicroStation DGN Graphics file can only be opened as read-only in older 

MicroStation versions. The Converting ORD to InRoads and MicroStation process 

https://dotfiles.sd.gov/survey/smchap6.pdf
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should be followed each time the OpenRoads CAD file is updated and an older version 

of MicroStation is needed for design. 


